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@4 JOA GPS Map Service

1.Getting Started

1-1 Introduction

JOA GPS Map Service is real-time position tracking service using Google
Map.

The current position data collected by GPS Device is transmitted to SMS
Server (USB Dongle Type) by every period cycle. And the transmitted position
data can be displayed on Google Map using JOA GPS Map Service in your
PC.

To do this, you have to install the provided installation CD in your PC.

I Installation S/W can be downloaded from our website at no charge.
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1-2. Configuration of JOA GPS System

— Y- Wireless
é Communication
Network

GPS Device

SMS Sever
(USB Dongle Type)

JOA GPS Map Service

JOA Telecom Co., Ltd 4 Proprietary and Confidential



@’I JOA GPS Map Service

1-3. Period of position tracking

The current position data collected by GPS Device is transmitted to SMS
Server by every period cycle. The period is as follows.
(Please refer to Menu 5-3 for changing the period.)

® Default period is 10 minutes.

® Emergency period is 5 minutes.

® |f user set normal period under 5 minutes, emergency period follow
normal period user set. (ex. If normal period is 3 minutes, emergency
period is same.)

® |f normal period set from 6 to 9 minutes, emergency period change to
5 minutes.

JOA Telecom Co., Ltd 5 Proprietary and Confidential
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1-4. Installing JOA GPS Map Service

1-4-1. Insert the provided installation CD into the computer’'s CD drive. The
introductory screen appears automatically. Click Next to begin installation.

i'-_%l JOA GPS Map Service — InstallShield Yizard

Welcome to the InstallShield Wizard for J0A
GPS Map Service

The InstallShield(R) Wizard will install 208 GPS Map Service on
wour compuker, To continue, click Mext,

WARMIMG: This program is protected by copwright law and
inkernational treaties,

[ Next> | [ Cancel ]

1-4-2. Customer Information screen will be open. Enter your information, and
then click Next.

i'-_%l JOA GPS Map Service - InstallShield YWizard

Customer Information

Please enter wour information,

User Mame:

Organization:

[ < Back ” ek = ] [ Cancel ]

JOA Telecom Co., Ltd 6 Proprietary and Confidential
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1-4-3. To install the JOA GPS Map Service in the default location, click Next.

Ready to Install the Program screen will be open.

If you want to change the location, click Change. You can change the location

you want.

i'-_w!gl JOA GPS Map Service — InstallShield Wizard

Destination Folder

lick Mext to install to this Folder, or click Change ko install ko a different £

G Install 724 GPS Map Service to;
C:Program FilesW04 TelecomWI08 GPS Map Service

JOA GPS Map Service

[ < Back ] Mext =

)

Zancel

1-4-4. Click Install to continue installation.

i'-_%l JOA GPS Map Service — InstallShield Yizard

Ready to Install the Program

The wizard is ready to begin installation,
Click Install ko begin the installation,

exit the wizard,

If wou wank to review or change any of your installation settings, click Back. Click Cancel to

= Back ]| Inistall

||

Cancel

JOA Telecom Co., Ltd 7

Proprietary and Confidential




Mfefecom JOA GPS Map Service

1-4-5. Installation is in progress.

i JOA GPS Map Service - InstallShield Wizard M=l
Installing JOA GPS Map Service it

The program features vou selected are being installed.

Please wait while the Installshield Wizard installs 104 GP3 Map Service, This
may take several minukes,

Status:

1-4-6. Installation is done. Click Finish to exit the wizard.
i'-_%l JOA GPS Map Service — InstallShield Yizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed J04 GPS Map
Service, Click Finish o exit the wizard,

JOA Telecom Co., Ltd 8 Proprietary and Confidential
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2. Overview

Make sure the main screen of JOA GPS Map Service.

% JOA GPS Map Service
File Tools Help

JOA GPS Map Service

EEX

[-] Devices 8

Messages ®|

Device Status

E Al Messages _

‘You can see all messages.

Change

Time = Status

Al | Orline
Request Position
[¥IFixed recent Mo messages

@ File > Exit (exit from program)

Tools > Time zone (reset Time zone)

Help > About (Program version)

You can manage the added SMS Servers and GPS Devices.
Position data are displayed by dots and icons on Google Map.
You can manage the position data messages.

® @ E

JOA Telecom Co., Ltd
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3. Setting Time zone
When you run JOA GPS Map Service, you have to set Time zone first.

Time zone f'5_<|

Time zone
St time Fone

« Time zone CHEIEI= B &= Al
" Time offset UTC+09:00
« Time ‘\Wednesday, Septermber 01, 2010 5:51:23 PM

Change time zone ...

System | Predefined | Custom

CHetDl= ®=Al
LITC+09:00
Wednesday, September 01, 2010 5:51:33 P

[95 ®#--

If you want to reset, enter Tools on the menu. (Menu > Tools > Time zone)

JOA Telecom Co., Ltd 10 Proprietary and Confidential
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4. Device Manager

4-1. SMS Server

Device Manager Dz|

Device Manager
Marisge sms server and gos cient davices.

SMS Server - No Device

‘% GPS Device - No Device

New : Adding new SMS Server
Edit : Editing SMS Server
Delete : Deleting a SMS Server
Clear : Deleting all SMS Servers

4-1-1. Adding new SMS Server
Click New, and enter SMS Server information you have.

JOA Telecom Co., Ltd 11 Proprietary and Confidential
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SMS Server Deyice

New - SMS Server Device
AT mew SIS sarvar device.

Erter sarver Foemstion.

(¥ Basic Information... You Aave fa enfer B fams.
7 Mamne | | Max 32 characters.
207 Murnber | | Max 32 digt numbers,

[ additional Infor mation. ..

22 Maodel | | Max 32 characters.

7 Memo May J2F characters.

'f Ay \Cancel
Click Apply to complete adding.

Device Manager

Device Manager
Mariage sms server sng gos cient gavices.

- [ ] J08-1 (D1032899726) | SMS Server - JDA-1

« Name JOA-1

« Number 01092899726

« Model (C-300

+ Created 9/2/2010 12:00:21
< Memo test

‘4 GPS Device - No Device

You can add another SMS Server in the same way.

JOA Telecom Co., Ltd 12 Proprietary and Confidential
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4-1-2. Editing SMS Server
You can edit SMS Server information.

SKMS5 Server Device

Edit - SMS Server Device
Libgste the SMS sarver gevics.

Etar sariiar Farmation.

(@ Basic Information...

JOA GPS Map Service

X

You have fo anfer Hhie fems.

7 Name

| Max 32 characters.

< Number (01032899726

| May 32 oligt numbears,

(@ additional Information. ..

«» Model  |c-300

| Max 32 characters.

« Memo | test

Max fZF characters.

[P0 ®= .

JOA Telecom Co., Ltd

13

Proprietary and Confidential



M telecom JOA GPS Map Service

4-2. GPS Device

Device Manager

K

Device Manager
Matiage 5ms server sng qos chient gavices.

- [2] 108-1 (01092899726) SMS Server - J0A-1

' Name JOA-1

' Number 01092299726

« Model C-300

< Created 9/2/2010 12:00:21
< Memo test

&% %G

‘4 GPS Device - No Device

New : Adding new GPS Device

Edit : Editing GPS Device

Delete : Deleting a GPS Device

Clear : Deleting all GPS Devices

Clear All: Deleting all GPS Devices and the SMS Server

4-2-1. Adding new GPS Device
Click New, and enter GPS Device information you have.

JOA Telecom Co., Ltd 14 Proprietary and Confidential
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GRS Client Device

JOA GPS Map Service

MNew - GPS Device
Agd mew GPS client device.

Sivtar cliernt formation.

@ Basic Information...,

Vouw have fo enfar i Fams.

" Mamne || | Max 37 characters.
47 Mumber | | Max 32 dight numbers.
7 Type \ﬁ Person | Yehicle | Seiect one.

7 Server |JOA—1 (01092899726

b | Safact ana.

[ additional Infor mation...

7 Memo

May F28 charactars.

Apply

You have to select Type (Person or Vehicle) and Server you added.

Click Apply to complete adding.

Device Manager

Device Manager
Maisge sms servar and gos client gavices,

B—E‘ J04-1 (01092899726)

- crs1 (D1ea15E7E3) & Name J08-1

+ Model C-300

« Memo test

[3] sMS Server - 1DA-1

< Number 01092899726

« Created 9/2/2010 12:00:21

4 GPS Device - GPS-1

« Mame GP3-1
« Number 0168156763

 Type Person

< Period 10 minutes

« Status Safety

« Memo test

« Created 922010 14:52:09

« 5MS Server 01092899726 (Disconnected)
« GED Fence Mot avalable

+ Registered Numbers None

You can add another GPS Device in the same way.

JOA Telecom Co., Ltd 15
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4-2-2. Editing GPS Device
You can edit_ GPS Device information.
GPS Client Device

Edit - GPS Device
Lirdate fhe GRS clisnt davics,

Ertar et ronmstion.

(7 Basic Information. ..

JOA GPS Map Service

X

Fou have fo enfar this fams.

7 Marme

| May 32 characfers.

< MNumber [0168156763

| May 32 digit numbais,

Person

@ Twe | & | &

Yiehicle | Safact one.

« Server | 10A-1 (01092599726

M | Safact ona.

(@ additional Information. ..

< Mema  |test

Max 128 characters.

[P0 ®-. .

Click Apply to complete editing.

JOA Telecom Co., Ltd 16
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5. Device Detall

5-1. Connecting SMS Server
You have to connect SMS Server to your PC using JOA SMS Control Agent.

5-1-1. Connecting SMS Server to your PC
Connect SMS Server to USB port on your PC.

I For connecting SMS Server to PC, JOA USB Driver should be installed in
your PC. Driver is in the provided installation CD or you can download from
our website.

JOA Telecom Co., Ltd 17 Proprietary and Confidential
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5-1-2. Starting JOA SMS Control Agent

# JOA GPS Map Service

File Toolz Helg

JOA GPS Map Service

EEX]

] Devices

Device

# () Map- 1081

ViBseages

[:]30A-1 (1)
= 01092899726
test.

Status

& 1 6rsa

Select SMS Server and click Detail or double click Egicon.

SEryer

5 Al Messages -~

‘You can gee all messages.

Change

Time - Status

al | orline

Request Position

ied recent Mo messages

SMS Server - JOA-1

' Mame 104-1

" Number 01092899725

« Model C-300

« Created 97272010 12:00:21
" Port Mot set

«" Status Disconneched

« Memo test

Shaw getzied iwormation shout & SMS sorer

Make sure SMS Server information and enter Agent.

JOA Telecom Co., Ltd
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JOA GPS Map Service

JOA SMS Control Agent (928993726)

File ()

JOA SMS Control Agent

(01092899725)

v2.0

Connection

Server Information

Murnber : | ‘

Port . |Not set

T

Status |Disc|:|nnected ‘

Model : | ‘

Hide l

If the connection between SMS Server and your PC is correct, you can get

SMS Server information.

JOA SMS Control Agent (92899726)

File (E]

JOA SMS Control Agent

(01092899720)

w20

Connection

Port |cop.r1 g

Status . |Cunnected |

Server Information

Maodel : |QSC6E|1EI—CBDD— 1 [Der 18 2005|

Nurmber : |01092599725 |

Hide: I

JOA Telecom Co., Ltd
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Close the window and make sure SMS Server status.

SMS Server

SMS Server - JOA-1
Show getaied mibrmation sbout 3 SIS sarvar

' Name 10A-1

" Number 01092899726

+ Model C-300

" Created 9/2/2010 12:00:21
' Port COM 8

+ Status Connected

+ Memo test

JOA Telecom Co., Ltd 20 Proprietary and Confidential
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5-2. Connecting GPS Device

To use JOA GPS Map Service, you have to connect GPS Device to SMS
Server.

# JOA GPS Map Service

ElE&
File Toolz Helg
[ Devices ® ‘ () Map - GPS-1 ‘ Missanes ® |
Dewice Status No item ‘ B Al Messages -~
= [3] 10a-1 (1) qr ¥ 5
[ T You can see all messages.
b 1 GP5-1 £ &
= Change
test
Time - Status
al | orline
Request Position
- - [¥]Fixed recent Mo messages
il %

Select GPS Device and click Detail or double click Edicon.

GPS Device - GPS-1
Show getaficd prmation about 3 GPS device.

« Mame GPS-1
" Number 0168156763
" Created 9/2/2010 14:52:09
« Type Parson
« Period 10 minutes
+ 5M5 Server 01092899726 (Disconnected)
+ GED Fence Mot available
#1, Mot set
#2, Mot set
#3, Mot =et
« Status Safety
+ Registered Numbers None
« Memo test

¥ U o —

JOA Telecom Co., Ltd 21
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Click Connect to start.

Connection

Connection - GPS-1
Corrert SVIS server and GRS delire

SMS Server GPS Device

K

-~

| |

A Disconnected
J0A-1 GPS-1
(010922997261 M1628156763

Message

@ Connecton

Are you sure you want to connect with GPS server
2

o coms CEE—

—

@ Connection

SMS Server GPS Device
—
2 A1
J0A-1 GP5-1
(01092399726 M168156763)

SMS server and GPS device are connecting...

Flease, Wait for answer from GPS device.

Time left 1 minute 59 seconds

EA—

Wait until the connection is done.

JOA Telecom Co., Ltd
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3

@ Connection

SMS server and GPS device were successfully
connectad.

The connection is done correctly.

Make sure GPS Device status

GPS5 Device

GPS Device - GPS-1
Shaw detaiied ixbrmation sbout 3 GPS device.

+ Mame GPS-1 o COnect
«" Number 0168156763
« Created 9/2/2010 14:52:09 ™ Feariod
+ Type Person
+ Period 10 minutes ﬁ EI=0)FEEE
" 5MIS Server 01092899726 (Connected)
%" GED Fence Mot available

#1, Mot zet

#2, Mot zet

#3, Mot set
+ Status Safety
+ Registered Numbers MNone
+ Memo test

B8 Req) Numbers

JOA Telecom Co., Ltd 23 Proprietary and Confidential
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5-3. Changing Period

Select GPS Device that you want to change the tracking period.

# JOA GPS Map Service

ElE&
File Toolz Helg
[ Devices ® ‘ () Map - GPS-1 ‘ Missanes ® |
Dievice Statuis No iterm ‘ 5 Al Messages »
= [7] 10a-1(2) r |
5 ‘You can gee all messages.
6 1 ars1
0168155763 P
test
& 2 G52 Time - Status
al | orline
Request Position
- = [¥]Fixed recent Mo messages
Il (s

Click Detail or double click GPS Device you select.

GPS Device

GPS Device - GPS-1
Show detaiied formation sbout & GRS derice.

+ Mame GPS-1
" Number 0168156763
" Created 9/2/2010 14:52:09
" Type Person
+ Period 10 minutes
+" §MIS Server 01092899726 (Connected)
+ GED Fence Mot available
#1, Mot zet
#2, Mot set
#3, Mot set
+ Status Safety
+ Registered Numbers None
+ Memo test

.1 o —

JOA Telecom Co., Ltd 24
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Default period is 10minutes. If you don’t want to receive the position
information, click No report.

Period D_(|

Period - GPS-1
Ehange racking pariod

" Mame GPS-1
« Number 0168156763
" Period 10 minutes

Mew Period rminLtE

Mo repart

JOA Telecom Co., Ltd 25 Proprietary and Confidential
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5-4. Setting GEO Fence

GEO Fence is another name of safety-zone. GPS Device sends SMS notice
to the registered phone number of protector, whenever one get out of the
GEO Fence or get in.

(Please refer to Menu 5-5 for changing the period.)

# GEO Fence

GEO Fence - GPS-1
Show the GEO fancing vales,
> o o

(] Fence #1
Status Disabled
Style Mot set

Edit Center

(] Fence #2
Status Disabled
Style Not set

Edit Center

[] Fence #3
Status Disabled
Style Mot set

Edit Center

FBEX

|‘ Enabled Disabled ]

[] Fence #1
Style

Circle Paolygon

Base
<10.4941, -66.8794 >

Radius
159 meter

JOA Telecom Co., Ltd 26 Proprietary and Confidential
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-Polygon Style-

¥, GEO Fence

GEO Fence #1 - Edit
You can set the GEQ fancing vailties,

£ [ Enabled Digabled ]
[“] Fence #1
Style
Vertex

-

. <10,4926, -565.8818:
2, « 10,4926, -65.8806:
3 2104926, -66.6794 >
4. <10.4926, -66.67581 >
5. «10.4926, -65.8769
6. «10.4956, -65.8769
7. «10.4956, -66.8781 >
8. «10.4956, -66.8794
9, «10.4956, -66.8206
10, <10,4956, 66,8818

| Clear |

You can set the limits of GEO Fence by dragging icons. To apply GEO Fence,
you have to click Enabled, if not click Disabled.

Click Apply to complete setting.

Message

X

@ GED Fence

Are you sure you want to change the GEO fence
values 7

JOA Telecom Co., Ltd 27 Proprietary and Confidential
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@ GEQ Fence
SMS Server GPS Device
N K\
10A-1 GP5-1
(01092800726 01631567630

GEC fence is chaging...

Please, \Wait for answer from GPS device,

[N

Titne left 1 minute 57 seconds

)
& —

]

@ GEC Fence

6 GED fence has been successfully changed.

A

JOA Telecom Co., Ltd 28 Proprietary and Confidential
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Make sure GEO Fence status.

# GEO Fence

GEO Fence - GPS-1

[-] Fence #1

Status Enabled

Style Polygon

Vertex 10 Mumbers
<10,45926, -66.8818=
<10.4926, -66.8806

|

<10,4926, -66,8794 e
Edit Center —l

[-| Fence #2

Status Enabled

Style Circle

Base «10.4958, -66.8710=
Radius 451 meters

edt [ conter |

-] Fence #3
Status Disabled
Style Mot set

Edit: Center

If you want to move in the center of GEO Fence, click Center.

JOA Telecom Co., Ltd 29 Proprietary and Confidential
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JOA GPS Map Service

5-5. Registering the phone number of protector

Begistered Numbers

Registered Numbers - GPS-1
Chiarnge reqistered numtars

« Name GPS-1
" Number 0162156763
+ Registered Numbers
#1 @ Mot set
#2 1 Mot set
#3 1 Mot set

Mew Registered Mumbers

@ »1: | |

GED Fence

GEC Fence

GEC Fence

X]

Clear

Clear

Clear

These numbers can receive Emergency SMS and Geo Fence report SMS.

Click Apply to complete.

JOA Telecom Co., Ltd 30
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5-6. Resetting GPS Device

If you want reset GPS Device, click Reset All. The connection between GPS
Device and SMS Server is broken.

GPS Device X

GPS Device - GPS-1
Show detadled informstion sbout & GFS davics.

« Mame GPS-1 o COnMECt
" Mumber 0168156763
« Created 9/2/2010 14:52:00 ™ period
+ Type Person
+ Period 10 minutes ﬁ (-EQ) Fence
" SWIS Server 01092299726 (Connected) m REORNINTNETS
«" GED Fence Mot available

#1, Mot set —

" Eesetall
#2, Mot set =
#3, Mot set

# Status Safety
+ Registered Numbers None
« Memo test

JOA Telecom Co., Ltd 31 Proprietary and Confidential



M telecom

6. Managing the position data messages

On the right side of map, position data messages appear.

# JOA GPS Map Service

File Toolz Helg

JOA GPS Map Service

EEX]

] Devices

u‘ () Map - GPS-1

IMessages ®

Device

Status | [GPS-1

= [7] 10a-1(2)

i 1 GPs1
0168156763
test

& 2. aPs2

5 Al Messages -~

oG

6-1. Message Filter

You can filter the messages.

Filter

Message Filter

You cary filter the messsges.

-All Messages-

&1l Messages

‘ [&#| Daily Messages ‘ [ custom Messages

You car see the aif messsges.

‘You can gee all messages.

Change

Time  ~ Status
T grppen1zEne AR
10,9942 % -66.6793

ineter, 0 kinfh, 0 satellte
922010 17:26:25
9212010 17:26:16
/22010 17:25:56
9/2/2010 17:25:31

&

R0

(T T

7| 9{2f2010 17:22:42

9/2/2010 17:22:31

= 9/2f2010 172223

9/2/2010 17:32:13

al | Onling
Request Position

[¥IFied recent 149

JOA Telecom Co., Ltd
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Filter
Message Filter
You can filter the messsges.
3] &1 Messages ‘ [ Daily Messages ‘ [ Custom Messages

-Daily Messages-

(X)

You can sefect 5 Gate 10 588 B Messsge.
Thursday, September 02, 2010

>

49 |

1 3 4
5 6 7 8 9 10 11
12 13 14 15 16 17 13

19 20 Z1 22 23 24 25
26 27 28 29 30

-Custom Messages-

Filter

Message Filter
¥ou car fiftar the messages,

®

JOA GPS Map Service

[&8] &1l Messages | [ Daily Messages | &8 Custom Messages

You oo set the time rarge.

Reference Time @ Current Time

Set Time

Until 1 Day Ago

: Day EI: Hour

JOA Telecom Co., Ltd
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6-2. Message Manager
You can control the position data messages.
®. Message Manager g@@

Messages
MaErRSge Mes5ages
Time Coordinate Altitude Speed Status Satelites  Cell E Dt
= 9f2/2010 17:35:23 10,4500 % -66,8750 Ometer  Okm/h Safaty 1] il
:__—'j 9f2/2010 17:27:42 10,4942 x -66,8793 0 meter 0 kmyfh Emergency & Fer 0 L @EE@
= 9/2f/2010 17:26:36 10,4200 % -66,8793 0 meter 0 kmyfh Emergency & Fer O C % Clear
= 9f2/2010 17:26:16 10,4800 ¥ -66,8793 Ometer  0Okmfh Fenhce Out 1] L et &l
= 9/2/2010 17:25:56 10,4200 % -66,8793 0 meter 0 kmyfh Fence Out ] r
= 9/2f/2010 17:25:31 10,4942 % -66,8793 0 meter 0 kmyfh Fence Out ] r
= 9f2f2010 1722042 10,4930 ¥ -66.8700 0 meter 0 krnfh Safety a C
= 9f2f2010 17:22:31 10,4950 ¥ -66,.8900 0 meter 0 krnfh Safety a C
= 9f2f2010 17:22:23 10,4950 ¥ 66,8793 0 meter 0 krnfh Safety a C
= 9f2f2010 17:22:13 10,4942 ¥ 66,8793 0 meter 0 krnfh Safety a C
T 9f2f2010 17:27:42 10,4942 % -66,8793 0 meter 0 kmyfh Emergency & Fer 0 r
T 9f2f2010 17:26:36 10,4200 % -66,8793 0 meter 0 kmyfh Emergency & Fer 0 r
T 9f2f2010 17:26:16 10,4200 % -66,8793 0 meter 0 kmyfh Fence Out ] r
T 9f2f2010 17:25:56 10,4200 % -66,8793 0 meter 0 kmyfh Fence Out ] r
T 9f2f2010 17:25:31 10,4942 % -66,8793 0 meter 0 kmyfh Fence Out ] r
= e F Nt T R B B Pha TR k'] A0 AN eSS OO M orm—— M Lo Pl 1 n rv
< ?
Orline Offline Safety Fence Out | Emergency

Click Detail to get the detailed information.

If you want to delete the messages, click Delete or Clear (delete all).
You can filter the messages by Online/Offline or Safety/Fence Out/Emergency.
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6-3. Emergency Warning

In emergency situation, a warning light blinks 3 times.

£ JOA GPS Map Service
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Lo -

# Emergency
A Fence out

Click |6PS-1 A to get the detail.

GPS-1 - Emergency Fence Qut
Show status af the gos cliant davice,

@ Client Device Information ...

+ Name GPS-1

« Number 0168156753

" Type Person

+ GED Fence Using 2 areas

« Status Emergency & Fence Out

(¥ Message Information. .

o Time 9f2/2010 17:58:31

+ Coordinates 10,4601, -66,8701
« altitude 0 meter

« Speed O km/h

+ Satellites 0

« Cellular Signal O dB

+ Battery Level Mormal

+ GPS Antenna State MNormal
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Click '9 1o go the position of emergency situation.

Click =58 16 hide the warning marks.
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7. SMS Request for the address of GPS Device

7-1. Registered protectors can request for the current address of GPS Device
by sending SMS.
(Please refer to Menu 5-5)

7-2. Send SMS command to SMS Server’s number. Command is #FIND.

Ex) #FIND [GPS Device number]
I No need to care for Upper and lower case, and it can’t contain spaces.

<Send>

7-3. Receive the message from SMS Server.
Ex) #FIND: [DATETIME] [ADDRESS] [LATITUDE x LONGITUDE]

<Receive>
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FCC (Federal Communications Commission)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions;
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,

Including interference that may cause undesired operations

Caution
This equipment may generate or use radio frequency energy. Changes or modifications to this equipment may cause
harmful interference unless the modifications are expressly approved in the instruction manual. The user could lose the

authority to operate this equipment if an unauthorized change or modification is made.

Information to User

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation.

This equipment generates uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technical for help.

Body-worn Operation
This device was tested for typical body-worn operations with 5mm distance between the user’s body and this device.
In order to meet RF Maximum permissible Exposure Safety Guidelines, a minimum distance of 5mm shall be maintained

between this device and personnel during transmitter operation.
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